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QviCorfac User’s Guide 

 

QviCorfac is a utility for XY calibration of large-travel QVI measuring machines.  Large-travel 

machines require a special calibration process because the size of the XY stage is significantly 

larger than the calibration artifact. 

 

This document outlines the multi-position nonlinear calibration process using a 25-point grid 

artifact. 

 

Prerequisites 
Before you embark on a multi-position calibration mission, please make sure you have a good 

understanding of the following concepts: 

 

• Single-position calibration (standard process on most OGP / QVI machines) 

• Basic understanding of component-wise nonlinear error plots (see the QviCorview User's 

Guide) 
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1. The Process 

For an overview of the multi-position calibration procedure, see the Large Travel XY Stage 

calibration manual, P/N 790431. 

 

2. The Software 

2.1. Overview 

The main features of QviCorfac are the following: 

• Support for two distinct styles of data collection for calibration 

• Relevant hardware parameters can be extracted from the machine's host PC 

• Multiple grid measurements are automatically stitched into a single correction 

map using best-fit least-squares method 

• All calibration and verification data can be conveniently stored in a single file for 

later retrieval, continuation and/or review. 

2.2. Main window layout 

 

 

Figure 1.  The main QviCorfac window 

 

The main application window consists of a menu and a work area below it.  The work 

area is a Notebook, whose tabs represent unique calibrations.  By default, one empty 
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calibration is created when the application is first started, with a Notebook tab named 

"blank".  You work with a calibration by clicking on its tab in the workbook. 

 

A calibration window under a selected tab is split into two windows, separated by a 

vertical sash.  The sash can be dragged left and right using the mouse to accommodate the 

window contents, as the user deems necessary.  As shown in Figure 2, the window on the 

left contains a tree-like representation of the calibration.  As each node in the tree is 

selected, its contents appear in the window to the right. 

 

 

Figure 2.  Session calibration tree 

 

At a minimum, a default blank calibration contains the following items: 

• Preferences 

• Data 

• Results 

• Grid Position 1 

 

The following paragraphs describe each of these items in detail: 

 

2.2.1. Preferences 

 

This section defines global calibration properties.  Some of the global properties 

directly affect calibration results, while others do not. 

 

Load Parameters from Host PC 

 

 

Figure 3.  Load parameters button 
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Make sure that the correct software is selected in the General tab, then click the 

button "Load Parameters from Host PC" to automatically load the relevant data 

from the machine's PC to the Preferences.  This is a convenience feature for the 

calibrator.  Instead of manually entering values like scale resolutions, scale 

configurations, machine serial number, etc., this feature provides a quick and 

reliable shortcut.  Note that the host machine’s software is not automatically 

detected (e.g., there may be multiple metrology software packages installed, and it 

is up to the calibrator to select the correct one). 

 

The Preferences window is subdivided into three main categories, listed under 

tabs with the following names: 

 

2.2.1.1.General – this tab contains general information about the machine. 

 

 

Figure 4.  Preferences - general tab 

Use this tab to enter general information about the calibration: 

• Machine Name – the machine model name, such as CNC 900 

• Machine S/N* - the machine’s serial number 

• Units – either inches or millimeters 

• Stage Travel* – the overall X and Y travel of the stage 

• Software – the software that will use the results of this calibration 

• Specifications* – the E1 and E2 tolerances for evaluating XY stage 

performance with corrections applied. 

• Multi-Position Setup: 
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o Number of grid positions during calibration – this depends on the 

relative size of the XY stage and the grid artifact. Generally, the 

larger the stage, the more grid positions will be necessary to 

perform calibration. 

o Number of expected unique points in the overall pattern – after 

calibration data is collected, the number of points in the grid 

pattern will be less than the total number of sampled points 

because of overlap; set the expected number here. 

o Neighbor tolerance – during overlap calculations, a square box is 

applied around each sampled point to determine which other points 

overlap with it.  The square’s side dimension is twice this 

tolerance. 

• Warning options: 

o Warn if the machine serial number does not match the serial 

number in the verification reports 

o Warn if number of expected unique points does not match the 

number of unique points found by the software after stitching the 

collected data 

• Config file – load or save a file that contains all the options in Preferences. 

 
* The “Load Parameters” button can automatically populate these items. 

 

2.2.1.2. Certification – define the grid data file and the certification scheme. 
 

 

Figure 5. Preferences - Certification tab 

 

DO NOT EDIT THESE 

SETTINGS. 

LEAVE AT DEFAULT. 
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The grid data file usually comes with the certified grid artifact on a floppy disk.  

The certification scheme simply defines the grid layout.  It is described by: 

• The start point number (either zero or one) 

• The grid origin point number (13 by default) 

• The grid’s first alignment point (11 by default) 

• The grid’s second alignment point (15 by default) 

 
Note: PTB dot plates use a “1-1-5” alignment scheme.  That is, the grid origin is #1, the first alignment point 

is also #1, and the second alignment point is #5. 

 

The certification scheme information is only relevant when the measure style is 

set to “Verifications with offsets” (see 2.2.2 below). 

 

2.2.1.3.Scales –define the hardware scale configuration. 

 

 

Figure 6. Preferences - Scales tab 
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The X and Y scales are of primary concern here.  Each axis can have either single 

or dual scales.  If there are dual scales, then the arrangement of the primary and 

secondary scales must be defined as well.  Do this by selecting the appropriate 

choice in the “Setup” list.  Set the appropriate scale resolutions here as well.  By 

default, 0.5-micron scales are used.  This tab also defines the XY Squareness 

factor value. 
 

Note: All of the settings on this tab can be automatically populated by the “Load Parameters from Host PC” 

button. 

 

2.2.2. Data 

 

 

Figure 7.  Calibration tree - Data item 

 

This window defines the measure style.  Two choices are available: 

• Verifications with offsets 

• Raw nonlinear data 

 

The “Verifications with offsets” style is the legacy measurement style that was 

used when this calibration process was first developed.  It is more time-

consuming than the “Raw nonlinear” style because the grid’s coordinates have to 

be measured and recorded, but it does not require the machine’s existing nonlinear 

correction setup to be disturbed until the end of the data collection process.  The 

disadvantage is that the grid is measured only in the forward direction.  The 

advantage is that the grid can be measured multiple times to obtain an explicit 

measure of repeatability while collecting calibration data. 

 

The “Raw nonlinear data” style, on the other hand, inherently provides the 

necessary grid offsets; but it requires that the machine be locally calibrated over 

each grid position.  The local calibration is temporary and is typically not a 

problem.  The primary advantage of this method is that the grid is measured in the 

forward and the reverse direction, thus minimizing hysteresis effects.  The 
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disadvantage is that the calibration report does not provide repeatability data.  

This necessitates a number of verification runs (typically three) before the 

calibration to establish the machine’s repeatability.  This is highly recommended 

because good repeatability establishes a comfortable confidence level in the 

overall calibration. 

 

The difference in calibration results between the two methods is negligible.  The 

raw nonlinear measurement approach is the default and is highly recommended 

because it is faster and less prone to operator error. 

 

2.2.3. Results 

This window contains all results of the calibration.  The results section is empty 

until calibration data is collected and the results are calculated.  The color of this 

tree item shows the state of the results.  If it is green, the results are "clean": they 

are either empty or have been calculated, and no changes have been made to the 

inputs.  If it is red, it means that some input data has changed, and the results must 

be recalculated.  The results are broken down into the following categories: 

 

2.2.3.1. Linear results 

 

Here is a sample display of linear results: 

 

 

Figure 8.  Linear results (sample) 
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All results pertaining to linear factors are stored here.  This includes the following 

information: 

   

• XY Squareness – F Avg, Old, New 

• X Linear Scales – F Avg, F1, F2, X1 Old, X1 New, X2 Old, X2 New 

• Y Linear Scales – F Avg, F1, F2, Y1 Old, Y1 New, Y2 Old, Y2 New 

 

Several of these values have similar meaning.  They can be described as follows: 

F Avg is the average calculated value based on the entire set of data. 

F1 (where applicable) is the average linear factor based on two grid columns 

nearest the stage home position. 

F2 (where applicable) is the average linear factor based on two grid columns 

farthest away from the stage home position. 

Old is the existing value of the particular linear factor. 

New is the new value of the particular linear factor, as calculated based on the 

input data. 

 

2.2.3.2. Nonlinear results 

 

Here is a sample display of nonlinear results: 

 

 

Figure 9.  Nonlinear results (sample) 

 

Fundamentally, this window shows three nonlinear results: 

 

• XXCORFAC 

• YYCORFAC 

• NLCORFAC 
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The window consists of two parts: a selection list on the left and a window with 

two tabs on the right – the Data tab and the Plot tab.  There are actually four 

selections in the list because NLCORFAC can be displayed in two ways – as 

component-wise plots, and as a whisker plot.  Both of those plots convey exactly 

the same information. 

 

When any of the choices in the selection list is highlighted, the Data tab always 

displays the raw contents of its associated correction file.  The Plot tab shows the 

associated visual view of the selected data. 

 

2.2.3.3. Statistics 

 

This window displays the fit statistics that were generated during the calculation 

procedure.  It includes a number of information items that may be useful during 

troubleshooting. 

 

 

IMPORTANT NOTE ABOUT THE APPLICATION OF RESULTS: 

Please note that the linear results and the nonlinear results represent equivalent 

calibration states of the machine, but in an exclusive manner.  That is, both sets of 

results cannot be applied at the same time if AND ONLY IF the results were 

obtained from the same set of input data.  By the same token, if you choose to 

apply only the nonlinear results, then NLCORFAC must be applied exclusive of 

XX/YY CORFAC. 

 

This stipulation is due to the fact that the metrology software applies stage 

corrections in the following order: 

• Linear corrections 

• Single-axis nonlinear corrections (XXCORFAC, YYCORFAC) 

• Two-dimensional nonlinear corrections (NLCORFAC) 

This order means that any correction affects all of the corrections that are applied 

downstream.  It is possible to calibrate a machine using any number of the above 

three corrections, provided that proper protocol is followed during calibration.  

The basic idea is that the corrections at any given level must be calculated after 

upstream corrections have been established and are deemed acceptable, AND with 

all of the downstream corrections disabled.  Once the corrections at the given 

level have been calculated and enabled, then one can move on to calculate any 

downstream corrections if necessary. 

 

2.2.4. Grid Position “X” 

 

If the measure style is set to "Verifications with offsets", then this window is used 

to input the grid offset coordinates; otherwise, there is nothing for the user to do 

here. 
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A grid position may be removed from a calibration by clicking the  button to the 

right of this tree item. 

 

2.2.4.1.Calibration 

 

This window contains the calibration input data for the particular grid position. 

 

 

Figure 10.  Calibration window without data 

 

To add files to this grid position’s calibration set, click the “Choose files…” 

button.  A dialog will pop up that will allow you to browse to the file(s) you want 

to add.  Note that you can select multiple files in the dialog by holding down the 

Ctrl key on the keyboard.  The file type that the dialog will allow you to select 

will vary depending on the measure style of the calibration: 

 

• Verification with offsets – the Calibration file picker will default to 

verification files (*.txt). 

• Raw NL data – the Calibration file picker will default to NLCORFAC files 

(*nlcorfac*.cfg). 

 

Note that the above defaults are provided merely for convenience.  You can load a 

file with any name and extension as long as you know that the file format is 

appropriate to the calibration style.  In such cases, select the “All files(*.*)” type 

in the browse dialog and choose your file(s). 

 

Also note that the current set of calibration data for the grid position is entirely 

replaced by the selection you make.  The old data set is discarded, and this 

operation cannot be reversed. 
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After you make a selection, the data will be loaded into the session and you will 

be able to view it in detail: 

 

 

Figure 11.  Calibration window with loaded data 

 

The left pane of the window contains three major controls: 

 

• File picker – the file that is highlighted in the list is displayed for review in 

this window.  The file(s) that are checked in the list are used during 

calibration calculations.  Files that are not selected in the list are ignored 

during calculations. 

• Global plot options – this simply contains a check box that auto-scales the 

y-axes of the data plots to fit the window. 

• Component wise linear factors – this text window lists the calculated 

component errors of the stage over the area of this grid position.  You can 

copy text from this window by highlighting it and clicking the right mouse 

button. 

 

The right pane of the window contains five tabs: 

 

• Data – displays the raw text view of the highlighted data file. 

• XY Deviations – displays the component wise plots.  If multiple files are 

checked on, their deviations are averaged. 

• E2 Deviations* – displays the E2 tunnel plot.  If multiple files are checked 

on, all the data is displayed as-is, without any averaging. 

• Repeatability* – displays the overall repeatability of the selected data. 

• Whisker – displays a whisker plot of the selected data.  If multiple files 

are checked on, their deviations are averaged. 
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* E2 deviations and Repeatability plots are not displayed for NLCORFAC files. 

 

2.2.4.2.Verification 

 

This window contains the verification data that is collected after placing the 

calibration into effect on the machine. 

 

This window has exactly the same look and feel as the Calibration window.  

There are only a few differences in functionality: 

• The verification data is for reference only.  It is never used in any 

calculations that affect the results of the calibration. 

• When using the file picker dialog, the file type always defaults to 

verification files regardless of the measure style. 

 

2.2.5. New Grid Position 

 

Additional grid positions can be added as necessary by clicking the  button to the right 

of this tree item.  No other action is possible here. 

 

2.3. Preference templates 

 

A calibration’s Preferences can be saved to a template file, which can be loaded later.  Select the 

Preferences tree item, then look for the text box labeled “Preferences file:” on the General tab.  

Click the “Load…” button to load an existing template, or click “Save As…” to save the current 

preferences to a template. 

 

QviCorfac is distributed with a number of Preference files for common machines, such as the 

Flash/CNC 900, the Flash 1500, Flash 1550, and Flash 1552.  These files can be found in the 

samples\templates directory within the application directory.  All of these templates 

assume that the calibrator will use a 24”x24” grid for the calibration.  If your calibration grid is 

of a different size, please refer to Appendix A for information about determining the number of 

grid positions as well as the number of expected unique points. 

 

2.4. Starting a new calibration 

 

A blank calibration is created automatically when the application is started.  You can also create 

a blank calibration at any time by pointing to the File>New menu. 

 

2.5. Retrieving a previously saved calibration 

 

Go to File>Open menu, browse to a previously saved calibration file, select it and click Open.  

The calibration will open in a new Notebook tab. 
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3. Appendix A – How to determine the number of grid positions 

and unique points 

 

3.1. Introduction 

Although QviCorfac is distributed with a number of preference templates, they all assume 

that the grid artifact is of a specific size.  Therefore, the number of calibration positions 

and the number of expected unique points in the preference templates are based on this 

assumption.  In the field, one may encounter situations that stipulate the use of a grid of a 

different size, or it may be advantageous to use a different number of grid positions for a 

particular calibration.  In any case, it is helpful to understand how to determine the 

number of grid positions and unique points based on a given machine stage and grid 

artifact. 

3.2. What are these “unique” points? 

First, let us consider a very simple hypothetical example before studying a real case.  

Let’s say that we want to calibrate an imaginary 48”x24” stage using a 24”x24” grid.  The 

stage travel is typically a few millimeters more than the nominal 48”x24”, and the 

dimensions of the 24”x24” grid are 23”x23”.  Hence, the XY spacing of the grid 

intersections is nominally 5.75”.  We can easily see by observation that the Y travel of the 

stage can only accommodate five grid rows i.e., one grid position.  What is the minimum 

number of grid positions that the X travel will allow?  To determine that, first divide the 

available X travel by the grid’s X spacing: 48” / 5.75” = 8.348…  Do not round the result 

up or down.  Simply drop the remainder and add 1.  This means that we can fit 9 columns 

of the grid within the stage’s X travel. 

 

The calibration works best when there is a grid intersection in the middle of stage travel.  

A standard OGP grid artifact has an odd number of rows and an odd number of columns.  

In order to have an intersection in the middle of the stage, any combination of grid 

positions must end up with an odd number of rows and columns.  Therefore, if you go 

through the procedure in the previous paragraph and find that your combination allows 

for an even number of rows or columns, you must reduce those number(s) by 1 to keep 

them odd.  For example, it is not possible to have a combined pattern that is 5 rows and 8 

columns.  Such a pattern does not have a column at its center.  Therefore, we must 

position the grid in such a way as to arrive at 7 columns in the pattern. 

 

Once you determine how many rows and columns you will use, draw a simple picture of 

the grid intersections to visualize the grid positions.  It is imperative that the first grid 

position is located in the center of stage travel.  All other grid positions should be offset 

from it.  Once you visualize the overall pattern, tally the number of unique points.  The 

unique points in the pattern are one of the following: 

• A single intersection in the pattern 

• Any number of intersections in the pattern that overlap with each other 
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3.3. How to determine the number of grid positions in general 

 

We must first determine the maximum number of grid rows and columns that will cover 

the calibration area of the stage.  As was partially illustrated by the imaginary example 

above in 3.2, the general approach to determining the number of rows and columns in the 

overall pattern is as follows: 

• Determine the X and Y dimensions of the grid. 

• Determine the X and Y spacing of the grid by dividing the appropriate dimension 

by (n – 1), where n is the number of intersections along that dimension. 

• Divide the stage travel of each axis by the appropriate grid spacing, as determined 

by the orientation of the grid on the stage.  Drop the decimal remainder from this 

result, and add 1.  This is the whole number of grid intersections that will fit along 

this axis. 

• If any count of rows or columns is an even number, reduce that count by 1 so that 

the counts of rows and columns are always odd.  This guarantees an intersection 

in the middle of the calibration area. 

 

To determine the minimum number of grid positions required to cover a given direction, 

use the following formula: 

 

integer. olenearest wh  the toup  Round

interest ofdirection  cover the  torequired positions grid ofnumber  MINIMUM  

interest ofdirection   thealong onsintersecti grid ofnumber   

interest ofdirection   thealong onsintersecti allowable ofnumber   
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It is imperative that any two positions of the grid on the stage must intersect at a 

minimum of two intersections for proper results.  On the other hand, do not cover the 

calibration area with too many grid positions.  This wastes the calibrator’s time and more 

importantly, does not improve the overall accuracy of the machine. 

 



QviCorfac -18- User’s Guide 

4. Appendix B - Examples of Grid Patterns 

 

Note: Unless otherwise specified in the diagrams, the grid used in the following 

illustrations is a 24”x24” grid (actual dimensions: 23”x23”). 
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Appendix B - Examples of Grid Patterns (continued) 
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Appendix B - Examples of Grid Patterns (continued) 
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Appendix B - Examples of Grid Patterns (continued) 
 

 

 

 
 



QviCorfac -22- User’s Guide 

Appendix B - Examples of Grid Patterns (continued) 
 

 

 

 
 

 


